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Introduction
This document describes how to upgrade to Fiery XF 9.0 from earlier program versions. It also explains how to
install and activate your Fiery XF 9.0 software package, connect to a Fiery XF server, and configure the software to
start printing with a minimum of settings.
The upgrade procedure varies, depending on which Fiery XF version you are currently running:

• To upgrade from Fiery XF version 7.x or 8.x, see Upgrading from Fiery XF 7.x or 8.x on page 6.

• To upgrade from Fiery XF version 6.5, see Upgrading from Fiery XF 6.5 on page 7.

This document is designed to help you get to grips with your new software as quickly as possible. For more detailed
information on Fiery Command WorkStation available tools and features, see Fiery Command WorkStation Help,
accessed from the Fiery Command WorkStation Help menu or from the Fiery Help website.
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Upgrading from Fiery XF 7.x or 8.x
If you have a valid System Maintenance and Software Agreement (SMSA) or an Enhanced Service Program contract
(ESP), a blue notification appears at the top right of the Job Center window when an update is available.
You can upgrade directly to Fiery XF 9.0 through the Online Updater in Fiery Server Control. For more information,
see the Fiery Command WorkStation Help.
Fiery XF 9.0 is available as a download from the Support & Downloads section of the Fiery website. For more
information on how to perform a clean install, see Installing Fiery XF 9.0 on page 9. If you do not have a valid
SMSA or ESP, you require a Fiery XF 9.0 license.
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Upgrading from Fiery XF 6.5
If you are currently running the Fiery XF server on a Windows computer, you can upgrade to version 9.0.
The following steps are required to prepare for upgrade:

• Back up your Fiery XF 6.5 system

• Uninstall Fiery XF 6.5

• Install Fiery XF 9.0

Now watch the video here.

Back up your Fiery XF 6.5 system

You can back up your current Fiery XF 6.5 server system and restore it in Fiery XF 9.0. Restoring a backup is the
easiest way to configure your new software.
A system backup saves:

• The Fiery XF server configuration

• All user settings

• All workflow settings, including presets, EPL linearization files, spot color tables, and profiles

• The printer configuration (excluding the printer's IP address)

1 In System Manager: Click File > Backup.

2 Select the check boxes of the items you want to back up.

3 Make sure that the desktop is defined as the backup location.
By selecting the desktop, you ensure that the backup file is not deleted when you uninstall your current version of
Fiery XF.

4 Click Save.

You can now uninstall Fiery XF 6.5.

Uninstall Fiery XF 6.5

You cannot run two versions of Fiery XF simultaneously on the same computer. You must uninstall Fiery XF 6.5
before you install your new software.
Make sure you have created a system backup before uninstalling Fiery XF 6.5.

Fiery XF 9.0 Quick Start Guide
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1 Go to Control Panel > Programs > Programs and Features.

2 In the list of installed programs, right-click Fiery XF, and click Uninstall.

3 Click Yes to confirm that you want to completely remove the selected application and all its features.

4 Restart the computer to complete the uninstall procedure.

You can now install Fiery XF 9.0.
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Installing Fiery XF 9.0
The Fiery XF 9.0 package is provided as a download.
To download the software, go to the Support & Downloads section of the Fiery website.
Fiery XF 9.0 consists of two separate pieces of software:

• The Fiery XF server component

Note: You must install the Fiery XF server component on a Windows computer, and the computer must have
Internet access.

• The Fiery Command WorkStation client component (for Windows and Mac)

Note: The Fiery Command WorkStation client component also contains Fiery Color Profiling Suite, which is
mandatory for creating profiles with Fiery XF. If you download the software from the Fiery website, make sure
that you download Fiery Command WorkStation and Fiery Color Profiling Suite.

You can install both components on one computer, or you can install the Fiery XF server on one computer and
Command WorkStation on a different computer.
The following steps are required:

• Install the Fiery XF server

• Activate a Fiery XF 9.0 license, or migrate a license from Fiery XF 6.5

Note:

Fiery XF 9.0 is software protected and does not require a dongle. You can migrate a dongle-protected Fiery XF
license for use with version 9.0.

• Install Command WorkStation

Note: You are required to create a Fiery Account if using Fiery Software Manager to download Command
WorkStation.

• Configure your printer and workflows, or restore a Fiery XF backup (if available)

To learn more about downloading the Fiery XF system software, watch the video here. For more information about
installation and licensing for Fiery XF, watch the video here.
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Install the Fiery XF 9.0 server

You can install the Fiery XF 9.0 server from a download.
Before you begin:

• Make sure you have your License Activation Code. You received your LAC in an email. The LAC is required to
activate the software.

Note: You do not require an LAC if you are upgrading from Fiery XF 6.5. The LAC is provided through the user
interface during the migration process.

• Deactivate all virus scanners.

1 On a Windows computer, install from download. Double-click the .iso file for the server component.

2 Click Run setup.exe.

3 Follow the onscreen instructions until the License Activation window opens in your browser.

4 Do one of the following:

• If you are a new user, activate the LAC. Click Activate, and follow the onscreen instructions.

• If you are an existing user and want to migrate from Fiery XF 6.5 to version 9.0, click Migrate. Then, plug in
your USB dongle, and follow the onscreen instructions.

Note:

Migration is only possible if you have a valid SMSA or ESP contract. If your SMSA or ESP contract has expired, a
message informs you to renew your contract before you can upgrade to Fiery XF 9.0.
Now watch the video here.

5 Click Finish, and close your browser.

6 Select Yes, I want to restart my computer now, and then click Finish.
The Fiery Server Control icon appears in the taskbar. When you right-click Fiery Server Control, the shortcut
menu provides items for starting the Fiery XF server, and downloading media profiles.

You can now install Command WorkStation.

Check for the latest Fiery XF updates

An update may be required to support the latest printer and cutter models. You can install updates using Fiery
Server Control.
1 In Fiery Server Control, click Fiery Online Updater.

If a newer version is available, Fiery Online Updater shows an overview of the new features and newly supported
printers and cutters.

2 Select the version to install.

3 Click Next.

Fiery XF 9.0 Quick Start Guide
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Fiery Account

With a Fiery Account, you can download the latest versions of Command WorkStation.

Create a Fiery Account in Fiery Software Manager

You are required to make a Fiery Account to download Command WorkStation and other Fiery applications using
Fiery Software Manager.
A valid email address is required to create a new Fiery Account.

1 In Fiery Software Manager, click Upgrade next to Fiery Command WorkStation Package.

2 Click Create an Account.

3 Follow the on-screen instructions to create a Fiery Account and verify your email.

Install Command WorkStation from Fiery Software Manager

You can install Command WorkStation on a Windows or Mac computer.
1 In Fiery Software Manager, click Upgrade next to Fiery Command WorkStation Package.

2 Click Sign In and log in with your Fiery Account user name and password.

3 Follow the on-screen instructions to install the Fiery Command WorkStation Package.
In Windows, you must restart your computer to complete the installation.
The Fiery Command WorkStation icon appears in the taskbar, and Command WorkStation starts.

You can now connect to your first Fiery XF server.

Install Command WorkStation from download

You can install Command WorkStation on a Windows or Mac computer.
1 Do one of the following:

• Install from download (Windows): Double-click the .exe file for Command WorkStation.

• Install from download (Mac): Double-click the .dmg file for Command WorkStation, open the Mac_User_SW
folder, and double-click the Fiery Applications.dmg file.

2 Do one of the following:

• Windows: Click Run MasterInstaller.exe

• Mac: Double-click Fiery Master Installer

Fiery XF 9.0 Quick Start Guide
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3 Follow the onscreen instructions to install the Fiery Command WorkStation Package.
In Windows, you must restart your computer to complete the installation.
The Fiery Command WorkStation icon appears in the taskbar, and Command WorkStation starts.

You can now connect to your first Fiery XF server.

Log on to your first Fiery XF server

You can log on to any Fiery XF server installed in your network. When you have set up a connection to a Fiery XF
server, Command WorkStation automatically logs on to that server whenever you restart the computer.
Before you begin: Make sure that the Fiery XF server you want to connect to is running. The Fiery Server Control
icon located in the taskbar of the server computer displays a white arrow on a green background when the server is
running.
The software normally starts automatically after installation is completed. If Command WorkStation is not already
started, click Fiery Server Control, and then click the green icon with the white arrow in the top right corner of the
window.

1 In the Welcome screen, click the Add (+) button.

2 Select a Fiery XF server from the list, or type a server name or IP address. Then, click Add.
Alternatively, click Advanced Search to search for a Fiery XF server within a specific IP address range, within a
specific subnet range, or to search for a keyword. Limit the search range of IP addresses as far as possible to avoid
unnecessary network traffic.

3 Select the admin user and type Fiery.1 as the password. Then, click Login.
These are the login credentials for the default administrator.

Now watch the video here.
You can now restore a Fiery XF 6.5 backup, or add your first printer.

Restore a system backup from Fiery XF 6.5

You can restore your Fiery XF 6.5 printer configurations in Command WorkStation.
Print configuration sets are restored as media in the new software. If no print configuration sets are available, the
media is created using the name of the EPL base linearization file.

1 In Server Manager: Click Server, click Backup & Restore, and then click Restore.

2 Select a backup file from the list.
By default, the list displays backup files that are saved to the desktop. If the backup file is saved elsewhere, click
Choose and browse to that location.

3 Click Restore.

4 Restart the Fiery server.
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Note the difference in the default login credentials for Fiery XF and Command WorkStation:

• Fiery XF
User: Admin
Password: Admin

• Command WorkStation
User: admin
Password: Fiery.1

The Fiery XF 6.5 login credentials are restored with the backup. After restoring a Fiery XF backup, you can log on to
Command WorkStation with your Fiery XF user name and password.

Add your first printer

You must add a printer before you can import jobs. Your license determines which printers are available for selection
in the software.
1 Click Add Printer.

The New Printer dialog box opens.

2 Select a printer manufacturer.

3 Select a printer type.
You can type in the Search field to filter the list of devices.
If available, it is recommended that you always select a printer type with FAST DRIVE in its name. For more
information, see FAST DRIVE on page 14.

4 Type a name for your printer (optional).
This is the name that is displayed in the software. By default, Command WorkStation displays the printer type.
You can overwrite the default name.

5 Add a description (optional).
For example, you can enter the printer location, or the type of media inserted in the printer.

6 Click Next.

7 Configure the printer connection. Do one of the following:
The printer must be switched on. Otherwise it cannot be detected.

• Configure a network printer on page 14

• Configure a printer connected through USB on page 14

• Configure for print-to-file output on page 14

• Configure a network printer and upload file to printer on page 15

8 Click Finish.
The Server Manager window opens.

Fiery XF 9.0 Quick Start Guide
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Now watch the video here.
You can now configure the software.

FAST DRIVE

Some printer models support FAST DRIVE. FAST DRIVE accelerates the job processing speed by using the GPU
(graphics processing unit) instead of the CPU (central processing unit). It is available on some later versions of Fiery
proServer Premium and requires a special license.
Command WorkStation provides both FAST DRIVE and non-FAST DRIVE printer drivers. If available, it is
recommended that you always select a printer type with FAST DRIVE in its name. The older printer drivers are
available to ensure compatibility and color consistency with calibration files created in earlier versions of Command
WorkStation.
FAST DRIVE is supported only for base linearization files that were created in Fiery XF 6.5 or later. Calibration files
that were created in Fiery XF 6.4 or earlier cannot be used with the FAST DRIVE printer driver.
In Job Editor, you can see in the Source File Information panel of the File tab whether your job has been accelerated
using the FAST DRIVE printer driver.

Configure a network printer

You can connect to a printer through its IP address.
1 Under Connection type, select Print via IP network, and type the printer’s IP address.

2 Select the type of TCP/IP protocol that your printer uses for data transfer.
Most printers support the RAW protocol and print to port 9100. The LPR protocol is normally reserved for Unix
systems or print servers with multiple interfaces. In most cases, you can leave the box blank. Refer to your printer
manual or ask your system administrator if you are unsure.

Note: EFI VUTEk printers communicate through port 8013.

Configure a printer connected through USB

You can print to a local printer that is connected to the server computer through USB.
1 Under Connection type, select Print via port.

2 Under Port, select the port.

Configure for print-to-file output

You can define a naming format and select an export folder in which to save print files for EFI wide-format printers.
Print files from EFI VUTEk printers are saved in RTL or TIFF formats to the specified Export folder. The Bitmap,
GIF, or PNG files are used to display a preview of the job on the VUTEk User Interface. You can open Bitmap, GIF,
or PNG files in any conventional graphics program.
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Note: GIF files are created by default. You can turn off the setting in the printer's Special Settings panel of Server
Manager, if required.
Print files from EFI Matan, EFI superwide roll-to-roll, and Reggiani printers are saved as separated TIFF files to the
specified Export folder. If you select an Export folder that resides in the network, you must type access rights to the
folder.

1 Under Connection type, select File output.

2 Define the export path (optional).
Use the default export path, or click Choose and browse to a different folder.

3 Select a naming format for the print files.
The default naming format is job order_job name_job ID_tile number_page number_Date. You can define a
custom naming format that may also contain custom text, and any of the following variables:

Variable Description

%count Counter

%jobid Job ID

%t Tile number

%p Page number

%out Printer

%cm Color mode

%job Job name/nesting name

%res Resolution

%work Workflow

%date Date

%order Job order

Note: File names are easier to read if you add a separator, such as an underline or a hyphen, between two
variables.

Configure a network printer and upload file to printer

You can connect a EFI VUTEk XT or EFI VUTEk MCORR printer through its IP address and upload print data to a
folder on the printer.
1 Under Connection type, select Print via IP network, and type the IP address of the printer that supports network

printing.

2 For the JDF Export path field, specify the shared folder, /vutek/Integration, on the VUTEk printer.
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3 Type the user name and password credentials to access the shared folder on the VUTEk printer.

Note: Set both the Username field as xfjdfintegration and the Password field as Fiery.1.

Configure unique ID of the printer

You can modify the unique identifier of your printer.
When you create a printer in Server Manager in the Printer Information tab, there is a unique ID shown for each
printer (unique for each Fiery XF server). This ID represents the identifier for setting up Fiery IQ with Fiery XF.
You can use the created identifier or enter your own unique identifier for your device like the serial number for
connection purposes.
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Configure Command WorkStation
To configure Command WorkStation, you must install media profiles for your printer, and configure the media and
workflows.
Each printer is initially configured with one generic media and one generic workflow.

• The media defines ink type, media (type, source, size). Special printer settings, such as auto-cut mode, or white
ink printing, are available on a second tab. The media is linked to a media profile, which means that you can
define different printer-specific settings for each media. It is recommended that you create one media for each of
your media types. You can select the appropriate media when you import a job.

• Workflows define basic color management and job settings. You can automate your work processes by creating
custom workflows for each job type, and selecting an appropriate workflow when you import a job.

If you do not want to create custom media and workflows, you can apply the generic settings. However, in this case,
you may have to make the same custom settings to each job before printing. Creating custom media and workflows
that are tailored to your specific job requirements can save you a lot of time and do away with the need to make
individual settings to each job.

Note:

You do not have to configure Command WorkStation if you have a system backup of Fiery XF 6.5. Your system
configuration is transferred to the new software when you restore the backup. For more information, see Restore a
system backup from Fiery XF 6.5 on page 12.

Download and install media profiles

You can download new and updated media profiles for your printer. Media profiles are available for many different
printer models, media types, and resolutions.
Fiery continues to develop its products after product launch to improve functionality or to increase printer support.
It is recommended that you run the update procedure regularly to make sure that your media profiles are always up
to date.

1 In the taskbar: Right-click Fiery Server Control, and click Fiery Profiles Updater.
The Profile Update Service window opens.

2 Click Next.

3 Under Manufacturer/Model, click your printer manufacturer.

4 Under Media Profiles, select the media profiles that you want to install.
You can select media profiles for different printer manufacturers in one download.
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5 Click Download List (optional).
You can view the listed of selected media profiles. To add or remove media profiles from the list, click Add More
Profiles.

6 Click Download.

7 Click Finish.

The media profiles are downloaded and installed on your computer. Command WorkStation takes approximately
thirty seconds to detect the media profiles.

Configure media

The media in Command WorkStation describes the physical properties of the media you are printing on. It is
recommended that you create one custom media for each of your media types.
Make sure you have installed appropriate media profiles.

1 In Server Manager: On the sidebar, click Printers, and select the printer.

2 In the printer's tree view, click the Add (+) button next to Media. Then, type a unique name, and click Save.

3 Select the new custom media. On the Media tab, expand the Media Configuration panel.
All the available calibration files for your printer are listed under Resulting calibration(s). If the list is empty, you
must download appropriate media profiles through Fiery Profile Updater.

4 Select an ink type, a media name, and other media settings.
The aim is to find the correct combination of calibration file and ICC profile for your settings. Under Resulting
calibration(s), Command WorkStation displays only those calibration files and ICC profiles that are compatible
with the selected combination of media settings.

5 Under Resulting calibration(s), select an appropriate calibration file for your media settings.

6 On the Media tab, expand the Media Settings panel.

7 Select a media source: Roll media or sheet media.

8 Select a media format.
You can also define a custom media format. Custom media formats cannot be bigger than the printer's maximum
supported media size. Type the required width and height. Then, click the Add (+) button, and save your media
format under a unique name.
Custom media formats are useful for processing the following types of jobs:

• Nestings—Nestings can be difficult to manage if the printer is configured for oversize media or roll media.
Defining a more convenient sheet size gives you better control over the layout of nested jobs.

• Print-to-file jobs—You can create a print file for a printer that supports different media sizes.

9 On the Printer & Workflow Settings tab, expand the Special Settings panel.

10 Make the printer-specific settings that you want to incorporate into the media.

11 Click Save.
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For more information on editing media, see the online help.

Configure workflows

Command WorkStation uses workflows to assign a default group of settings to your jobs. It is recommended that
you create custom workflows to achieve the best results.
You can use workflows to apply uniform color management settings, or layout settings that affect job dimensions,
orientation, or media consumption. You can also use workflows to ensure that Command WorkStation prints all jobs
with marks or job labels.

1 In Server Manager: On the sidebar, click Printers, and select the printer. In the printer's tree view, click the Add
(+) button next to Workflow.
The Workflow Templates window opens.

2 Select the type of workflow and a template that best suits your needs, and click Load.

3 On the Color tab, expand the Color Management panel.

4 Under Presets, select the color management preset that is most suitable for your requirements.
Command WorkStation provides color management presets for production, photo, proofing, business graphics,
and grayscale output. They contain preselected source profiles, simulation profiles, and rendering intents suitable
for standard workflows, and ensure that you achieve good color reproduction.

5 On the File, Layout, Finishing, Color, Printer, and Verify tabs, select further settings that are applicable to your
workflow (optional).

6 Click Save.

7 Close Server Manager.

For more information on editing workflows, see the online help.
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Import and print a job
You can import jobs in the Job Center window of Command WorkStation. You can import individual jobs, or you
can select multiple jobs and import them as a nesting.
The steps below describe how to import a job directly in Command WorkStation. For more information on other
methods of job import, such as through a hot folder or virtual printer, see the online help.

1 In Job Center, in the toolbar, click Import.

2 Browse to your job, and click Open.
The Import Files dialog box opens.

3 Click the Add (+) button to import more than one job (optional).
If you import multiple jobs, you can sort the order in which they are listed, by selecting a job and then clicking
the up/down arrows.

4 Select the printer.

5 Select any of the available workflows or media for the specified printer.

• Workflow—Processes jobs using the settings of either the Generic (Default) workflow or another selected
workflow.

• Media—Processes jobs using the settings of either the Generic (Default) media or another selected media.

6 Select Nest all jobs (optional).
This setting imports all the listed jobs as a nesting. Alternatively, you can create a nesting later in Job Center from
individually imported jobs.

7 Select an import method.

• Hold—Allows you to edit held jobs before printing. Imported jobs receive the status "Spooled".
Held jobs are imported into the job list, but do not start printing. You can edit a held job and start the print
process manually when you are ready. Job settings override the settings from the workflow. For more
information on editing jobs, see the online help.
To edit a job, select it in the Job Center. Under Job Summary, click the pen icon, and type the number of
required copies. In the toolbar, click Print.

• Process and Hold—Processes jobs on import, but does not print them. Imported jobs receive the status
"Processed". You can start printing manually.

• Print—Imports, processes, and prints jobs automatically. Imported jobs receive the status "Printed". If you
need to edit jobs, you must cancel job processing first.
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Learning materials
Fiery provides many different types of learning materials in the form of videos and documentation to help you get
the maximum out of your software.

• Videos
Fiery provides an extensive set of instructional and how-to videos designed to equip you with all the information
that you will need to successfully operate your system. The courses start with the fundamentals and progress all
the way through to expert topics. You will find direct links to many videos throughout this online help.
Furthermore, a full list of all the available videos can be found at learning.fiery.com. You can use the Search
feature to find videos on any chosen topic.

• Documentation
The following types of documents are available for download from the Fiery website:

• User documents (Quick Start Guide, user manual, how-to articles on specific software features)

• Technical documents (release notes, system requirements, feature charts, etc.)

• Knowledge base (general how-to articles on color management, software options, workflows)

• Printer driver descriptions

• Command WorkStation Help menu
From the Help menu, you can find Fiery Command WorkStation Help as well as documentation for the
supported Fiery XF server. Click <server name> documentation where <server name> is the Fiery XF server to
view the documentation available for your Fiery XF server.
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